Thank You from the SDRC!

Dear Faculty,

Florida State University is committed to providing a quality education to all qualified students and does not discriminate on the basis of race, color, creed, gender, age, national origin, sexual orientation, or disability. The Student Disability Resource Center (SDRC) was established to serve as an advocate for FSU students with disabilities and to ensure that they are provided with reasonable accommodations.

As a primary advocate for students with disabilities, the SDRC works with faculty and staff to provide accommodations for the unique needs of students both in and out of the classroom.

By providing support services at no cost to students with disabilities, the Student Disability Resource Center offers an opportunity for students to achieve their academic and personal goals.

It is our mission at the SDRC to collaborate with and empower students to create an accessible and inclusive environment by identifying, minimizing, and where possible, eliminating barriers to equal access while encouraging equal participation for students with disabilities.

We are happy to provide training to any department at any time. Ranging from How to Provide Academic Accommodations to Universal Design, the SDRC staff is here to provide the information and support you need!

If you have any questions or concerns regarding the SDRC, please do not hesitate to contact me or any other SDRC staff member.

Thank you and Go Noles!

Dr. Shelley Ducatt
Director of the SDRC
Contents

Thank You from the SDRC! .............................................................................................................. 2
SDRC General Information .............................................................................................................. 4
  Location and Hours of Operation .............................................................................................. 4
  Staff ............................................................................................................................................. 5
Introduction .................................................................................................................................... 6
  Universal Design/Accessibility ..................................................................................................... 7
Frequently Asked Questions ........................................................................................................... 9
Explanation of Accommodations .................................................................................................. 18
Instructions ................................................................................................................................... 21
  Notetaking ................................................................................................................................. 21
  Testing ....................................................................................................................................... 21
  Alternative Text/Class Materials ............................................................................................... 29
  Tegrity ........................................................................................................................................ 34
Appendix A – Responsibilities in Relation to Academic Accommodations ….................. 35
Appendix B – Confidentiality Statement .................................................................................... 37
Appendix C – Student Statement of Understanding ................................................................. 38
Appendix D – Absence Accommodation Agreement ................................................................. 40
Appendix E – Agreement to Record Lectures ........................................................................... 41
Appendix F: Principles of UD for Instruction (UDI) ................................................................. 42
Appendix G - Grievance/Complaint Procedures for Persons with Disabilities ...................... 44
SDRC General Information

Location and Hours of Operation

Address
874 Traditions Way
108 Student Services Building
Tallahassee FL 32306-4167
(Located in the SSB building located at South Woodward and Traditions Way – better known for the attached parking garage and the Denny’s restaurant)
Mail Code: 4167

Phone/E-mail
Phone: 850-644-9566
TDD: 850-644-8504
Fax:
850-645-1852 Documentation
850-644-7164 Exam
E-Mail: sdrc@fsu.edu
Website: https://dos.fsu.edu/sdrc/

Hours
Office Hours:
Monday –Friday: 8:00a.m. - 5:00p.m.
Testing Center hours:
Monday – Thursday: 8:00a.m. – 5:30p.m.
Friday - 8:00a.m. – 4:30p.m.
*Hours may vary during finals week*

The office is closed for most major government holidays and also shuts down for the annual Dean of Students Staff Retreat that occurs every August.

*Holidays: Martin Luther King Jr. Day, Labor Day, Memorial Day, Veterans Day, Thanksgiving, Winter Holidays/New Year*
Staff

Dr. Shelley Ducatt, Director  
sducatt@fsu.edu  
(850) 644-9566

Jennifer Mitchell, Assistant Director  
jmitchell2@fsu.edu  
(850) 645-1854

Spencer Scruggs, Assistant Director  
scruggs@fsu.edu  
(850) 644-6827

Ann Clutter, Exam Lab Coordinator  
aclutter@admin.fsu.edu  
(850) 644-9566

KimBoo York, Assistive Technology Coordinator  
kimboo.york@fsu.edu  
(850) 644-5532

Marshaun Jackson, Program Assistant  
mdjackson@fsu.edu  
(850) 644-9566

Dexter Taylor, Transportation Services  
drtaylor@fsu.edu  
(850) 443-7140

Joshua Guffey, Graduate Assistant  
Jsg15e@my.fsu.edu  
(850) 645-0449
Introduction

Dear Faculty,

Thank you for your interest and support of students with disabilities at Florida State University. The staff of the Student Disability Resource Center have put together a manual of information and forms that we hope will be useful and informative for you. Our goal is to assist you when working with of students registered with the SDRC by providing information that will help you be more effective in your classroom, as well as helping the university maintain compliance with federal disability guidelines.

Please take a few moments to look through the handbook and familiarize yourself with the contents. We are hopeful this handbook will cover most of the questions and needs you will have as a faculty member. However, in the event you cannot find what you are looking for in this publication, please do not hesitate to contact the Student Disability Resource Center at 850-644-9566. You may also drop by anytime and visit our office in room 108 of the Student Services Building.

Thank you again for your assistance and support of students with disabilities at FSU. We appreciate you!

Dr. Shelley Ducatt
Assistant Dean/Director, Student Disability Resource Center
Florida State University
Universal Design/Accessibility

The basic principle of universal design (UD) is a simple one: “The design of products and environments to be usable by all people, to the greatest extent possible, without the need for adaptation or specialized design” (Center for Universal Design (CUD), 1997). In practice, this means simply that the environment or product has been designed for optimal use without the user having to adapt themselves or find alternative solutions. It is the difference between designing for full accessibility from the start versus spending costly effort to retrofit something that already exists.

An environmental example would be a set of low-incline ramps up the front of a building in place of stairs, allowing for people with any range of mobility issues to enter by the front entrance, rather than forcing people in wheelchairs or who have limited leg mobility to an alternative retrofitted “handicap” entrance in the back.

A course materials example that is fairly common these days is the ubiquitous PowerPoint presentation. A fully accessible version contains only necessary images, and all images have "alt-tag" descriptions that can be read by screen readers. Words do not "fade in" to overlap, and any embedded media (videos, music) is also accessible. Often, students will convert a PowerPoint presentation into a PDF in order to use it with a screen reader; if the file cannot be converted and still be fully informative, it is not accessible.

In both cases above, retrofitting something that is inaccessible (whether a classroom or a class reading) involves much more work and expense than if accessibility was incorporated from the start. When developing a syllabus, determining course materials and classroom presentations, and deciding on readings, starting with the idea of UD fully in mind will provide students with accessible materials and provide faculty peace of mind.

History and Underpinnings of UD

The term “universal design” was coined in the early 1970s by Ronald Mace, who was an internationally recognized architect, product designer, and educator (Burgstahler, 2008). The seven principles of UD were established by the Center for Universal Design in 1997, building on the work of people such as Mace in designing both building and products.

However, several higher education disability professionals have argued for a more comprehensive approach to matters such as classroom design, software development, and course design using UD. Dr. Sheryl Burgstahler, an early leader in this movement, champions the simple application of the basic seven principles of UD to higher education in a process she has termed “Universal Design in Higher Education (UDHE)” (Burgstahler, 2008). Others have slightly modified the set of seven principles by adding two more (for a total of nine) that are targeted specifically for learning environments (see Appendix D: Principles of UDI), which they term “Universal Design for Instruction (UDI)” (Scott, McGuire, & Shaw, 2003). It has also been
pointed out that recent advances in cognitive psychology “have important implications for the
design of twenty-first-century learning materials and environments” (Edyburn, 2011) which
have directly impacted the theory and practice of UD in learning environments.

Universal accessibility (UA), in contrast to UD, is a term that has entered the common parlance
from the information technology sector, where “accessibility” generally refers to the ability of
users of technology to interface with the software and/or hardware. However, since the term
“accessibility” is so closely associated with disability services, the terms are often used
synonymously outside of scholarly settings. Often, when people talk of UA, they are actually
discussing matters that fall under the umbrella of UD.
Frequently Asked Questions

What is a disability?

An individual with a disability is defined as any person who:

"has a physical or mental impairment which substantially limits one or more major life activities (including walking, seeing, hearing, speaking, breathing, learning, working, caring for oneself, or performing manual tasks), has a record of such an impairment, or is regarded as having such an impairment."

Isn't "disability" and "handicap" the same thing?

A "disability" is a condition caused by accident, trauma, genetics or disease that may limit a person's mobility, hearing, vision, speech, or mental function. A person may have more than one disability.

A "handicap" is a physical or attitudinal constraint imposed upon a person; for example, stairs, narrow doorways, and curbs are handicaps imposed upon people with disabilities who use wheelchairs.

Do I have the right to know the nature of a student's disability?

The information regarding a student's disability should be shared only when there is a compelling reason for disclosure. The U. S. Department of Justice has indicated that a faculty member generally does not have a need to know this information, only that it has been appropriately verified by the office assigned this responsibility on behalf of the institution. Students may submit their verification to the Student Disability Resource Center without disclosing to their instructors the specific nature of their disability. Upon a student's request for accommodations, the university and the instructor are required by law to appropriately accommodate the student in a timely manner. While students are not required to share their specific disability information, students are encouraged to discuss their specific needs with their instructors.

Should I refer a student to the Student Disability Resource Center?

Faculty members are encouraged to refer students to the Student Disability Resource Center if the student has disclosed that they have a disability. We would be more than happy to provide brochures to any academic department that would like to have them available as a student resource.

How are accommodations determined for a student with a disability?

Reasonable accommodations are determined on an individual basis after considering the specific disability and documentation of functional limitations in accordance with the ADA Amendments Act of 2008 (ADAAA), the Americans with Disabilities Act of 1990 (ADA) and Section 504 of the Rehabilitation Act of 1973. See the Association on Higher Education and
Disability (AHEAD) at [www.ahead.org](http://www.ahead.org) and the SDRC website at [www.dos.fsu.edu/sdrc](http://www.dos.fsu.edu/sdrc) for more information regarding documentation guidelines. Accommodations are designed to provide an equal educational opportunity not to give the student a competitive edge.

**How do I verify the eligibility of a student who simply tells me that he or she is disabled and requires accommodations?**

On the Florida State University campus the Student Disability Resource Center is regarded as the authority to verify disabilities and determine whether a student qualifies for academic accommodations. All students eligible for accommodations have presented the necessary documentation and been verified by the SDRC staff. Please do not provide accommodations to a student unless the letter of accommodation has been provided to you. If a student tells you that they have accommodations but do not provide you with a letter, please refer them to the SDRC to obtain a current faculty letter.

**What is a reasonable accommodation?**

A reasonable accommodation is a modification or adjustment to a course, program, service, job, activity, or facility that enables a qualified individual with a disability to have an equal opportunity to attain the same level of performance or to enjoy equal benefits and privileges as are available to an individual without a disability. Some common academic accommodations include extended time on tests, use of peer note takers, use of computer with spell check, and provision of sign language interpreters.

**How does a person become eligible to receive accommodations?**

To become eligible, a person must have a documented disability and inform the University that he or she is requesting accommodations based on that disability.

A student must:

1. Contact the Student Disability Resource Center;
2. Provide specific documentation of the disability from a qualified professional;
3. Consult with an advisor in Student Disability Resource Center to determine appropriate accommodations.

**Who determines the accommodation?**

Student Disability Resource Center staff determine the accommodations using:

- Documentation of the disability from qualified professionals provided by the student,
- Information gathered from an intake process, and information from history of the disability.

The determination of reasonable accommodations considers the following:
• Classroom or physical barriers,
• The array of accommodations that might remove the barriers,
• Whether or not the person has access to the course, program, service, job, activity, or facility without accommodations, and
• Whether essential elements of the course, program, service, job, activity, or facility are not compromised by the accommodations.

Won't providing accommodations on examinations give an unfair advantage to a student with a disability?

"Accommodations don't make things easier, just possible; in the same way eyeglasses do not improve the strength of the eyes, they just make it possible for the individual to see better. Accommodations are interventions that allow the learner to indicate what they know. Without the accommodations, the learner may not be able to overcome certain barriers." (Samuels, M. 1992 - Asking the Right Questions. The Learning Center, Calgary)

Accommodations are designed to lessen the effects of the disability and are required to provide fair and accurate testing to measure knowledge or expertise in the subject. Careful consideration must be given to requests for accommodations when the test is measuring a skill, particularly if that skill is an essential function or requirement of passing the course, such as typing at a certain speed or turning a patient for an x-ray. In such cases, please contact a Student Disability Resource Center staff member for guidance.

The purpose of academic accommodations is to adjust for the effect of the student's disability, not to dilute academic requirements. The evaluation and assigning of grades should have the same standards for all students, including students with disabilities. For many test takers, the most common accommodation is extended time. In specific circumstances, students may also require the use of readers and/or scribes, a modification of test format, the administration of examinations orally, or an alternative time for testing. For out-of-class assignments, the extension of deadlines may be justified, especially if the student is relying heavily on support services (readers for term papers, etc.).

How is extra time justified for students with learning disabilities?

Other students could improve test scores if they were allowed additional time as well. Various factors account for the need for extra time on tests for students with learning disabilities. These include: a) speed of processing; b) visual perceptual deficits; c) difficulty with mechanics of syntax, spelling and punctuation; and d) reading comprehension deficits. Research (at UC Berkeley, 1991 and the University of Toronto, 1993) on the effects of extended time on exams has shown dramatic improvements for students with learning disabilities, but only marginal improvement for students without learning disabilities. Rather than providing an unfair advantage in the class, extended time for exams allows these students to demonstrate their level of mastery of the course objectives, rather than reflecting the deficits innate to their learning disabilities. In other words, it 'levels the playing field.'
What do I do when a student discloses a disability?

Ask for the Letter of Accommodation from the student; this letter describes the accommodations that faculty are legally mandated to provide. During an office hour or at another convenient time, discuss the letter and the accommodations with the student. Students MUST present a letter from the Student Disability Resource Center to receive accommodations. If the student does not have a letter, he or she should be referred to the appropriate staff member at the Student Disability Resource Center to request services. SDRC staff will determine the appropriate accommodations after reviewing documentation of the disability provided by the student.

What if a student doesn't tell me about a disability until late in the semester?

Students have a responsibility to give instructors and the SDRC adequate time to arrange accommodations. All Student Disability Resource Center staff encourage students to identify early in the semester. Instructors can help by extending in class and in the syllabus an invitation for students to identify themselves early in the semester: "Any student who may need an accommodation due to a disability, please make an appointment to see me during my office hours. A letter from the Student Disability Resource Center authorizing your accommodations will be needed."

Once a student has identified to the instructor and requests disability-related accommodations authorized by the SDRC, the University has a legal responsibility to make reasonable attempts to accommodate the need, even late in the semester. There is no responsibility to provide accommodations prior to identification; for example, allowing the student to re-take exams with extended time.

Can I review the student's documentation of the disability?

The Student Disability Resource Center is the office designated to receive and interpret documentation of the disability. SDRC staff certifies eligibility for services and determines accommodations. Disability information is confidential and students are not required to disclose this information to instructors.

What if I suspect that a student has a disability?

Talk with the student about your concerns regarding his or her performance. If the concern seems disability-related, work into conversation with the student information about the Student Disability Resource Center and how to apply for services. You cannot directly ask the student if they have a disability. Whether to self-identify to the Student Disability Resource Center is the decision of the student; however, to receive accommodations, disclosure to the SDRC with proper documentation is required.

If the student has never been evaluated for a learning disability and/or Attention Deficit Disorder/Attention Deficit Hyperactivity Disorder, the Student Disability Resource Center will
provide a list of local resources where the student may be screened or tested. Some of the resources offer a sliding fee schedule.

What if a student with a disability is failing?
Treat the student as you would any student who is not performing well in your class. Invite the student to your office hour to discuss reasons for the failing performance and what resources the student may use to improve. Encourage the student to see the Student Disability Resource Center staff to discuss some additional strategies to improve his or her grades. Contact the SDRC staff member working with the student to discuss any concerns.

What if a student with a disability is often absent?
Talk with the student to discuss your concerns that absences are affecting class performance. Remind him or her of your policy on class absences. Determine with the student whether the missed work can be made up and make arrangements with the student to do so. Refer the student to Student Disability Resource Center if too much class work has been missed.

What is a note taker?
A note taker is usually another student in class who agrees to provide copies of lecture notes taken during class. The note taker may make copies of notes at the SDRC or use carbonless note taker paper available at no charge from Student Disability Services. The note taker may also choose to type notes during class on a laptop computer and then email the notes to the student and/or upload them into the SDRC clockwork system where all students with the note taking accommodation in that specific course will be able to access the notes. For more information on the note taking process, refer to the Instructions: Note taking section.

How can I assist a student with getting notes?
The Letter of Accommodation will document the need for note takers. Students who cannot take notes or have difficulty taking notes adequately due to the effects of their disability can be accommodated in a number of ways including: allowing them to tape record lectures, assisting them in obtaining an in-class volunteer note taker, and providing them with an outline of lecture materials and copies of overhead transparencies.

What should I do if a student who is deaf or hard of hearing shows up in my class without an interpreter?
In the unlikely event that a student shows up for the first day of class without an interpreter, the student should be referred to the Student Disability Resource Center. The SDRC will then attempt to schedule an interpreter or work with the student to rearrange his or her schedule into classes where an interpreter is already provided.

Who is responsible for requesting an interpreter?
Students requiring an interpreter for class must make the request to the Student Disability Resource Center. For outside class requirements, such as field trips or other assigned activities,
as well as office hours, students should request the interpreter from the SDRC at least two weeks ahead of time or more, depending on the event. The SDRC cannot guarantee an interpreter when requests are made less than two weeks before the event.

Do I need to alter my teaching style with an interpreter?

Interpreters are professionals who facilitate communication between hearing individuals and people who are deaf or hard of hearing. The role of the interpreter is similar to that of a foreign language translator: to bridge the communication gap between two parties.

Some adaptations in presentation style may be helpful when using a sign language interpreter. The interpreter will let you know if you need to slow down your rate of speaking or if they need you to repeat any information. A desk copy of the book is especially helpful for the interpreter when the class is using examples or doing exercises from the text. Please realize that if students are looking at the interpreter, they cannot be reading a book, writing, or taking notes; a pause for the students to finish their task may be required before continuing the lecture.

What can I expect if there is an interpreter in my classroom?

Interpreters are bound by the code of ethics developed by the National Registry of Interpreters for the Deaf, which specifies that interpreters are to serve as communication intermediaries who are not otherwise involved.

When an interpreter is present, speak directly to the deaf or hard of hearing person rather than to the interpreter, and avoid using phrases such as "tell him" or "ask her."

Speak normally, noting that there may be a lag time between the spoken message and the interpretation.

When referring to objects or written information, allow time for the translation to take place. Replace terms such as "here" and "there" with more specific terms, such as "on the second line" and "in the left corner."

In a conference room or class environment, the deaf student and interpreter will work out seating arrangements, with the interpreter usually located near the speaker.

Inform the interpreter in advance if there is an audiovisual element in a presentation, so arrangements can be made for lighting and positioning. All videos used in an academic course must be captioned to be accessible for the deaf student.

In sessions that extend longer than one hour, the interpreter may require a short break to maintain proficiency in interpreting.
What should I do if my class needs to evacuate the building due to an emergency?

Students should let you know at the beginning of the semester if they will need assistance during an emergency.

Students who are blind or have low vision may need a "buddy" to assist them exit the building.

Some students with head injuries or psychiatric disabilities may become confused or disoriented during an emergency and may also need a "buddy."

Students who use wheelchairs should NOT use the elevator but should wait for Security to safely assist them to exit the building. Security has the schedules of students who will need emergency evacuation. To prevent injuries, instructors or other untrained personnel should NOT attempt to evacuate a student who uses a wheelchair. Please wait for trained emergency personnel.

What if a student has a seizure in my classroom?

The Student Disability Resource Center encourages students with seizure disorders to inform their instructors about what should be done if a seizure occurs during class time. Some students request that Security be called immediately; others request action as listed below. Seizures happen when there is a sudden electrical discharge in the brain. Each individual has a unique reaction. A seizure can result in a relatively slight reaction, such as a short lapse in attention, or a more severe reaction known as a grand mal, which involves convulsions. Seizure disorders are generally controlled by medication, so the possibility of a seizure in the classroom is rare. If one does occur, the following actions are suggested: Keep calm. Ease the student to the floor and open the collar of the shirt. You cannot stop a seizure. Let it run its course and do not try to revive the student. Remove hard, sharp, or hot objects that may injure the student, but do not interfere with his or her movements. Do not force anything between the student's teeth. Turn the student's head to one side for release of saliva. Place something soft under the head. Make sure that breathing is unobstructed, but do not be concerned if breathing is irregular. When the student regains consciousness, let him or her rest as long as desired. To help orient the student to time and space, suggest where he or she is and what happened. Speak reassuringly to the student, especially as the seizure ends. The student may be agitated or confused for several minutes afterward. Don't leave the student alone until he or she is clearheaded. Ask whether you can call a friend or relative to help him or her get home. If the seizure lasts beyond a few minutes, or if the student seems to pass from one seizure to another without regaining consciousness, contact the campus Safety and Security office. This rarely happens, but when it does, it should be treated immediately.

What is the "SDRC testing center"?

The SDRC has an in-house testing center located on premise. The main room holds roughly 30 students, and there are five individual rooms for those students who have "private room" as an
accommodation. There are nine computers available for tests that are online or use digital media (such as images or recordings). Faculty is always welcome to come by the SDRC to tour the facility.

Is the testing environment at the SDRC monitored?

Yes. Exams are kept locked in a secure location until time to administer. The testing environment at the SDRC is monitored by physical proctors, video cameras and a remote system that allows staff members to see what students are doing on their computer screen during exams on which a computer may be used. Instructors are welcome at any time to visit our facility to insure that the integrity of the exam process is being upheld.

We are located in the Student Services Building, 874 Traditions Ways - Room 108.

In the event that academic dishonesty is suspected, our policy is to stop the exam and notify the instructor immediately. Our office does not make decisions on penalties, but will provide any information regarding what was witnessed.

What do I need to do if my student(s) will be taking exams in the SDRC exam lab?

Students are responsible for scheduling tests to be taken at the SDRC testing center, but faculty are given immediate notification by email whenever a student does so. At that point it is incumbent on faculty to approve the time/date of the test and to deliver the test to the testing center supervisor in a timely manner. General expectations are that tests will be delivered at least two business days prior to the testing date, although more time may be needed if the test needs to be made accessible through conversion or by supplementing (e.g. tactile images for blind students). For complete information and instructions, please visit the "Instructions: Testing" section of this handbook.

What if my student needs information provided in an alternative format?

PLEASE NOTE: Document conversion, especially for students who are blind, is a time consuming process. Any time inaccessible materials are used in class, it causes a delay for the student trying to learn and use that information.

Ideally, all class materials should be created as fully accessible documents, including text books, required readings, class handouts, slide show presentations, videos, audio recordings, etc. For more information on how to make sure that the documents used in a class are accessible, please visit the "Instructions: Alternative Text/Class Materials" section of this handbook.

In the event that faculty use materials that are not accessible, it is incumbent on the student to request that those materials be converted into an accessible format by the SDRC. The alt-text conversion team at the SDRC attempts to work with faculty when needed to verify that text conversions are equitable.
For more information, please refer to the "Instructions: Alternative Text/Class Materials" section of this handbook.

Who is eligible to use the SDRC Van service?

- Students, faculty, and staff who have mobility impairments, temporary or permanent, may be eligible to use the Florida State Accessible Van. Priority will be given to those individuals with permanent mobility impairments, and every effort will be made to accommodate those with temporary impairments.
- Potential riders must complete an application and provide documentation that supports the use of van transportation.
- Only students, faculty, and staff who have mobility issues may ride the van.

Will the SDRC van drive students to their off campus apartment or appointments?

No. The van is only for on-campus transportation. Transportation to and from campus is the sole responsibility of the rider.
Explanation of Accommodations

Listed below are some of the most common accommodations faculty will see on an accommodations letter. The header text is the official description of the accommodation in question. The text after that explains what it means, how and when it applies, and any limitations. If you do not see the accommodation you have questions about listed here, please email the SDRC (sdrc@fsu.edu) or call (850-644-9566).

50% Extended Time on Exams, Quizzes and Tests

Extended time ensures that the student’s performance is reflective of the student’s mastery of material rather than the speed at which a student performs. This accommodation does not apply to take-home exams. Extended time does apply to all quizzes, tests and exams administered via Blackboard in which a timer is being used.

100% Extended Time on Exams, Quizzes and Tests

Extended time ensures that the student’s performance is reflective of the student’s mastery of material rather than the speed at which a student performs. This accommodation does not apply to take-home exams. Extended time does apply to all quizzes, tests and exams administered via Blackboard in which a timer is being used.

Reduced Distraction Testing Environment (not a separate room)

Faculty have two options when providing testing accommodations to students. If all of the students testing accommodations can be provided within the Department then faculty are welcome to test students within the department. If a faculty member is unable to provide all of a student’s testing accommodations within the department then the student will need to test at the SDRC Testing Center. Acceptable reduced distraction testing environments include a classroom with a minimal number of other students taking an exam for the size of the space provided, a study room, a library space, a conference room, or an instructor’s office. If you would like to utilize a different type of testing space please check with the SDRC prior to administering the exam to ensure that the space will qualify as reduced distraction.

Separate room

Students has the option of testing in a private room (with a proctor present or a proctor in visual contact at all times).
Permission to record classes/lectures using a digital recording device (e.g., Livescribe Smart Pen, digital recorder, etc.)

Students must bring the faculty member an “Agreement to Record Lectures as an Approved Accommodation” form (ref. Appendix E – Agreement to Record Lectures) With this form the student is agreeing that: the contents of the course are the property of the professor; the recording will be used solely for access to the course; the contents will be used for this course only and for the current semester only; they will not share the recording in part or whole with any other person; and the student will use the recording for the course and then delete all recorded lectures at the end of the semester or upon dropping the course.

Consideration with regard to due dates/extensions on assignments

In special situations a student’s disability-related symptoms are variable and may increase during the course of the semester making extra time to complete class assignments necessary. When a student has a disability with unpredictable or cyclical acute episodes, an accommodation to flex due dates/deadlines may be appropriate. Work, travel, or other extracurricular activities are not valid reasons for changing the deadlines of assignments. The student will need to meet with you as early in the semester as possible to determine the limits under which flexibility in due dates/deadlines might be granted (e.g., how long of an extension may be granted on an assignment). After this meeting, it is the student’s responsibility to email you and the assigned disability specialist a summary of the agreed upon limits. Please note that agreed upon deadline extensions are considered binding; the student may not request ongoing extensions on a given assignment and must complete the assignment by the agreed upon date.

Scribe

With the assistance of a scribe, the student’s answers to an exam/test/quiz question will be written down verbatim, without grammatical assistance. This may be handwritten or typed into a computer, depending on the nature of the test and the nature of the student's disability.

Use of Computer for Essay Exam

With the use of assistive technology to record answers to a test/exam/quiz, this adjustment does not give the student permission to use computer programs such as grammar check or spell check to complete exams/quizzes/tests, unless the student has been granted prior written permission for the student to utilize such programs. The SDRC will arrange for a testing scribe and or the appropriate assistive technology when the student provides the required five business day prior notice (sdrc@fsu.edu).
No Scantrons

The allows for the ability to write multiple choice exams directly on the test. If Scantron forms are required, a proctor can complete the form, but the copy of the exam must remain with the Scantron to verify that it was correctly completed.

Use of basic (4-function) calculator

The core elements of the exam must not be measuring basic math computation. Calculators that are programmable or that have memory storage will not be permitted without the approval of the instructor.

Note-taking assistance

In order to receive this accommodation, students must be present for class and be attentive. In rare instances the student may have an accommodation to receive notes when not present for class.
Instructions

Notetaking

If a student has the in-class notetaking accommodation, faculty have several options in helping to insure that a note taker is found:

- **Option 1:** Instructors may locate two in-class note-takers for the course; one to serve as the primary note-taker and the other to serve in the primary note-takers absence. NCR carbonless paper should be used by the note-takers and are available through the Student Disability Resource Center. Guidelines for doing so are included in the Note-taking Memo that is attached to the NCR note pads. The instructor would then forward them to the student within 24 hours of class.

- **Option 2:** Instructors may locate two in class note-takers who take notes on laptop computer. The note takers would e-mail the notes to the instructor, or the student if the student’s email is provided in such a way that the student cannot be identified, at the conclusion of class. If forwarded to the instructor, the notes should either be forwarded to the student, posted in an accessible location (Blackboard or Website) or printed and provided to the student In order to receive this accommodation, students must be present for class and be attentive. This must be done within 24 hours of class.

- **Option 3:** Instructors may give copies of classroom lecture notes, power point presentation, transparencies, or overheads that they use for daily lectures. Instructors may utilize Blackboard or by posting notes online. Power Point presentations, overheads and transparencies must be provided to the student prior to the lecture.

Testing

Students are responsible for scheduling tests to be taken at the SDRC testing center, but faculty are given immediate notification by email whenever a student does so. At that point it is incumbent on faculty to approve the time/date of the test and to deliver the test to the testing center supervisor in a timely manner. General expectations are that tests will be delivered at least two business days prior to the testing date, although more time may be needed if the test needs to be made accessible through conversion or by supplementing (e.g. tactile images for blind students).

Online testing: The SDRC testing center computers are configured to administer tests using Blackboard, eGrade, and ExamSoft. If you are using a testing service that is not listed here, please contact the SCRC testing center at least a week prior to testing at sdrc@fsu.edu.

Below are complete explanations and instructions of the SDRC testing process.
Clockwork Procedures for Instructors

Eligibility:

Students that receive exam accommodations may need to test in the Student Disability Resource Center Exam Lab. The student should provide you with their accommodation letter prior to scheduling a quiz, test or exam with SDRC. If you receive a request from a student from whom you have not received a letter please inform us as soon as possible.

Security and Integrity of Examination Process:

Exams are kept locked in a secure location until time to administer. The testing environment at the SDRC is monitored by physical proctors, video cameras and a remote system that allows staff members to see what students are doing on their computer screen during exams on which a computer may be used. Instructors are welcome at any time to visit our facility to insure that the integrity of the exam process is being upheld.

Academic Dishonesty:

In the event that academic dishonesty is suspected, our policy is to stop the exam and notify the instructor immediately. Our office does not make decisions on penalties, but will provide any information regarding what was witnessed.

Testing Location:

The testing center is located inside the Student Disability Resource center, located in the Student Services Building, 874 Traditions Ways - Room 108.

Any questions regarding exam accommodations should be sent to:

Student Disability Resource Center Exam Lab
sdrc@fsu.edu
850-645-1853

Scheduling Tests:

Students are required to schedule tests with our office at least a week in advance using the Clockwork test scheduler. This means if a test is to take place on Monday, they will need to register it on the previous Monday. We understand that there may be circumstances when one week advance notice cannot be given (pop quizzes). Our office can work with those cases as needed and discuss a plan with the instructor and student for those times.

The link below has the instructions for students scheduling a test:
https://dos.fsu.edu/sdrc/services/exam-lab
Once a student has scheduled a test with our office, you will receive an email notification requesting that you submit the test. If you think that you have received this notification in error, please let us know as soon as possible.

Below is an example of the notification:

Date: Sunday January 10, 2016 3:14 AM
To: ********
From: sdrc@admin.fsu.edu
Subject: Test booking notification for 1114
Body:
Hello (Instructor Name)

This is an automatic email to notify you of an upcoming test booking. The following student(s) have registered to write their test for your course with the SDRC:

Student Name
Student EMP ID
Date and time of test booking

Please visit our website to provide information about your test, including a copy of the test:

https://clockwork.fsu.edu/ClockWork/user/instructor/default.aspx

PLEASE NOTE: If the student is blind/low-vision, deaf/hard-of-hearing, or in any way mobility impaired, the test or test components (images, videos, audio recordings) may need to be converted for accessibility. Please strive to submit tests that are universally accessible; the SDRC Testing Center staff makes all reasonable attempts to check tests for accessibility before they are distributed to students but that is no guarantee that we can identify problems before the test date.

If you have any questions about the submission process or how to check if your test is universally accessible, please contact the testing center at sdrc@fsu.edu.

When you receive this message, please visit our website to provide information about your test, including a copy of the test:
https://clockwork.fsu.edu/ClockWork/user/instructor/default.aspx

Confirming/Uploading Tests

You will enter the Instructor Information website and see the information below.
* This shows an instructor with multiple courses.

Click on the link indicated with the star (⭐️)
* This shows an instructor with multiple exam dates. Click on the “confirm” link for the exam.

![Scheduled tests and examinations for:](image)

* Enter the exam details (date and time), then click next. If this is a Blackboard exam that has a window, just enter the first available date and time slot. The instructions for setting up extended time for a specific user will be posted at the end of this document.

![1. Test / Exam Information](image)
* This shows a list of students who have scheduled their exam. Review, acknowledge receipt and click next if there are no questions regarding the exam.

2. Students scheduled to-date for

Below is the list of students that have registered to write this test with us so far. Please review this list and click the 'Next' button at the bottom of the page to continue.

* This will let the SDRC know your preferred method of exam delivery. Make your choices (examples below) by checking the boxes that apply, then click on next.
* This is the page where you will upload the test and submit exam information. Please note any special instructions regarding the exam (notes allowed, calculator use, etc...) should be on the cover page of the exam or sent via email to sdrc@fsu.edu.

**It is important to upload file and then click on submit changes.**

<table>
<thead>
<tr>
<th>4. Confirm exam details for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please review the information below and click the 'Submit changes' button at the bottom of this form to submit your changes. If you have any questions or concerns please do not hesitate to contact us.</td>
</tr>
<tr>
<td><strong>Test details</strong></td>
</tr>
<tr>
<td>MAC 1114 sect. 0006 (2161) MAIN</td>
</tr>
<tr>
<td>Wed April 20, 2016 . 10:45 AM - 11:40 AM</td>
</tr>
<tr>
<td><strong>Test information</strong></td>
</tr>
<tr>
<td>Exam will be uploaded to Clockwork</td>
</tr>
<tr>
<td>Exam will be emailed to instructor</td>
</tr>
<tr>
<td>Exam will be returned via campus mail(4-5 days for delivery)</td>
</tr>
<tr>
<td><strong>File upload</strong></td>
</tr>
<tr>
<td>Note: If you are not able to upload a digital copy of the exam here, a paper copy of the exams, booklets and/or scantron sheets (for each student registered in your course) must be delivered to the Exams Office in advance of your scheduled test or exam, at least one business day in advance.</td>
</tr>
<tr>
<td>Select test/exam file to submit:</td>
</tr>
<tr>
<td>Previously uploaded tests:</td>
</tr>
<tr>
<td>No records to display.</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

**Please note** that you must click the Submit changes button in order to confirm your test to us.

Please print a copy for your records.
* You have completed the instructor process. **Don't forget to logout.**

**Blackboard: setting extra time**

Below is a set of instructions for setting extra time in blackboard for students who get extended time on tests/exams. If you should have any questions, please visit the FSU Blackboard User Support site: [https://support.campus.fsu.edu/home](https://support.campus.fsu.edu/home)

1. In the exam settings go to option 3. **Click on Add User or Group**

2. A pop up page will appear showing all of the users enrolled in the course or organization. Select the user you want to give an exam exception to.

3. You will then be brought back to the original window. Now you will have option to provide the user with unlimited attempts, a unique timer, availability (to make that exam available for only that user) and the option to remove force completion.
Alternative Text/Class Materials

Students who have an accommodation for alternative text are eligible to receive copies of their textbooks in an accessible format, such as PDF, MS Word, DAISY, or Braille. This often does not impact faculty in any way, except for three corollaries:

1. Textbooks or other required readings that are available or exist solely online;
2. Class materials such as handouts, slide presentations, and other media (videos, recordings, etc.).
3. Tests/exams

Faculty should always endeavor to insure that all materials used for the class are accessible. That can mean anything from properly scanning a paper into a text-recognized PDF to captioning videos used in class. Taking the two issues above separately:

Online readings

1. If the primary text for the course is online or has elements that are online (such as interactive tutorials or videos), it is incumbent on faculty to first make sure that the material is universally accessible, including through the use of screen readers, captions for videos, transcripts of audio recordings, etc. If you are uncertain how to check, please contact the SDRC at sdrc@fsu.edu.
2. Journal articles: Many full-text journal articles available via library databases are either showing in proprietary format, or as embedded PDFs. They are not always equally accessible, and it might be necessary for the article to be available in another format (for example, printed or downloaded as a PDF). Please check before assigning the reading.

Class materials

1. Printed handouts: Try to make printed handouts available in alternative formats (.docx or PDF) prior to class by posting them on blackboard. If you do not wish to have them available before class, post them right before class so that students who have accommodations can download accessible versions during class to their laptops or tablets, in order to have the information available at the same time as the class. Sending copies after class does not meet "equal access" guidelines.
2. Slide Presentations: Slide presentations created in PowerPoint or OpenOffice can be very difficult for students to access. A fully accessible version contains only necessary images, and all images have "alt-tag" descriptions that can be read by screen readers. Words do not "fade in" to overlap, and any embedded media (videos, music) is also accessible. Often, students will convert a PowerPoint presentation into a PDF in order to use it with a screen reader; if the file cannot be converted and still be fully informative, it is not accessible. Note: Prezi presentations/files are not considered accessible and use of the service is not recommended.
3. **Video**: Any video screened in class must be captioned. A transcription is *not* considered equitable. There are many ways to caption videos, including free services (such as YouTube's), but in general it is very expensive to hire captionists to caption a video, even a short one. It is better to source material that has already been professionally captioned. The SDRC can assist your department in finding and hiring a company to caption your videos, but we offer not do the service in-house.

4. **Audio**: Audio files must be transcribed, unless they are music. Again, the SDRC can assist your department in finding and hiring a company to do transcription, but we do not offer the service in-house.

**Basics on making class materials accessible**

**Word Documents**

There are a lot of aspects that can contribute to whether a document is accessible or not, but in general it is easy to do and does not take much time. Here is a short list of things to be aware of:

- **Navigation**:
  - Use "heading styles" in long documents (creates imbedded navigation/structure that can be used with screen/text readers)
  - Use short titles in headings
  - Ensure all heading styles are in the correct order
- **Use hyperlink text that is meaningful** (in addition to the URL, give the link a title or description)
- **Avoid using repeated blank characters** (spaces, tabs, "enter" key) as formatting tools
- **Do not use color alone to convey information**, or as a navigation aid.
- **Images**:
  - Add alternative text to images and objects (this can be read by screen readers)
  - Avoid using floating objects (place "in line" with text)
  - Avoid image watermarks
  - Only add images that are necessary, not decorative
- **Tables**:
  - Use simple table structure
  - Specify column header rows in tables (allows for context and easy navigation)
  - Avoid using blank cells for formatting tables
  - Structure layout tables for easy navigation
- **Embedded media**:
  - Include closed captions for any audio
  - Include descriptions/transcriptions of any video
Once your document is complete and has been saved in the "*.docx" format, use the built-in accessibility checker in Word to verify that the document is accessible. It is found by going to File > Info > Inspect Document > Check for Issues (MS Word 365/2016) or File > Info > Prepare for Sharing > Check Accessibility (MS Word 2010/2013). This will give you a complete list of items that are not accessible or problematic.

Resources:

Microsoft Support page for making Word documents accessible:

U.S. Dept. of Health and Human Services "Word 508 Checklist":

PDF files

PDF files are by their nature more difficult to make 100% accessible than other file formats. PDF files were originally intended to simply be "portable" versions of a document, much like making a photocopy of a piece of paper. Unlike Word or other word processing programs, PDF files were never meant to be very interactive and so were simply inaccessible for many years. Adobe has, over time, addressed a lot of these issues and a PDF can be made accessible fairly easily, as long as you know what to look for.

For the purposes of this explanation, it is assumed that the user will be making changes in a PDF file using Adobe Acrobat Pro, and already has some familiarity with the program:

- IF SCANNED: send directly to PDF if possible, and make sure the resulting scan is clean and level
- Apply "Text Recognition" so text is rendered as readable (under 'Tools > Text Recognition').
- Add alt-tag descriptions to all images
- Check reading order (are paragraphs in correct order?). (under 'Tools > Accessibility')
- Create internal navigation markers using "bookmark" tool
- Verify that file metadata is present and correct

Resources:

Adobe support page for making PDF files accessible:
Pictures/Images

Pictures and images include not just photographs but any image that conveys information visually, such as two-dimensional art (drawings, paintings), graphs, charts, maps, and memes. Depending on the file format and the type of document it is used in (Word, PowerPoint, or as an independent image) it is fairly easy to add an "alt-tag" to any image, which is a short description (125 words or less) of what is being shown.

Alternatively, the description can be included in the document as a caption.

A good goal for describing an image is to think about what information you would convey if you were describing it over the phone. Sometimes, it's not necessary to include every bit of information (such as a stock photo image of business people) and sometimes it is (charts of demographic information). Decide what information is being conveyed by the image versus what is necessary for the student to know. For instance, in a pie chart, it is far more important for the student to know the percentages involved than that it is a picture of big circle.

Information to include in the description of an image:

- Type (art, graph, map, photograph, etc.)
- Subject (people, mathematical equation, country/geographical location, etc.)
- Description (necessary data the student needs to know)

If it is impossible to adequately describe an image, the SDRC is able to make tactile images for students who are blind. These are often fairly simplistic due to the limitations of the technology involved, but can surmount many difficulties. If you feel that a tactile image may be best for your student, please contact the SDRC at sdrc@fsu.edu with your request.

Audio/Videos

Audio and video files are, by their nature, inaccessible to people with hearing loss. Best practices is that all such files be captioned and transcribed. Both processes are also time intensive and expensive to outsource, and neither is a service offered by the SDRC. Your department is responsible for the costs associated with captioning and transcribing. For this reason, it is recommended that files used in the classroom be vetted prior to use for accessibility, and that any which are not accessible be replaced.

U.S. Dept. of Health and Human Services "Multimedia File 508 Checklist":
Tests/Exams

All tests, quizzes, and exams need to be fully accessible. That includes being available in an alternative format (if online then available in a printed version; if a printed test, then available in digital format).

1. All images need to be described or, if a description would give away the answer, converted into a tactile image. (The SDRC is able to do most conversions if necessary, but it is critical for the test/exam to be delivered to the alt-text team at least 48 hours before testing in order to properly convert the materials.)
2. Non-music audio portions of tests either need to be transcribed or taken separately with the instructor (such as language verbal portions).
3. Video must be captioned.
4. Be aware of answers that need to be handwritten or require fine motor control, as some students have mobility impairments that prevent them from writing/drawing accurately or at all. There are several ways to address this type of situation, so please contact the SDRC testing center at sdrc@fsu.edu so we can help you find the right solution.

Formatting tests: The majority of tests administered at Florida State are either online or printed out. The originals often start as Word documents. If you are creating a test in Microsoft Word or any other word processing software, please follow these basic rules:

1. Single column only!
2. Full test, date, class (including section), instructor and form at the start of the test.
3. Be consistent with formatting tools such as numbered lists, that is, make sure all the questions are in a cohesive format (lists don't stop and restart, for instance).
4. No extraneous formatting or decorations (page frames, clip art, etc.)
5. No section breaks. Page breaks are acceptable but section breaks can cause problems with screen readers and other technology.
6. Try to avoid word-matching style question sections if possible. They are very difficult for blind students to navigate, as well as students with cognitive/spatial impairments.

Students using readers/scribes for tests are often at a disadvantage when the reader/scribe is unfamiliar with the subject. In these situations, try to arrange TA/GA from your department to act as the reader/scribe, if at all possible. This is easily arranged by contacting the Testing Center Supervisor at sdrc@fsu.edu.
Tegrity

Tegrity is a lecture-capture tool that lets you record audio and video using your webcam or computer screen. Videos can be recorded and shared in class, in your office, or at home easily by logging into Blackboard. The advantage of using Tegrity is that it gives all students in a class equal access to the class information in a secure environment. Faculty can record computer screen presentations along with an audio or webcam so students can review both simultaneously. It also keeps lectures in compliance with Florida State's copyright policy, and locks down videos to students taking the course.

Enabling Tegrity for a course is very simple and can be done through the course's blackboard site control panel:

1. Drop down the Control Panel menu.
2. Select Course Tools.
3. Select Tegrity Request Tool.
4. When the Tegrity Request Form loads, look under Service Request. Fill out the information and select Submit.
5. Allow 24 hours for Tegrity to be enabled on the course site. When this occurs, a "Tegrity Classes" link will appear on your course menu.

Florida State Tegrity overview, instructions, and trouble shooting: https://support.campus.fsu.edu/kb/article/539-tegrity-overview
Appendices

Appendix A – Responsibilities in Relation to Academic Accommodations

The Student Disability Resource Center, the students, and the faculty all share a role in the success of students by partnering with one another to achieve our mission and objectives.

The Student Disability Resource Center has the responsibility to:

- evaluate students based on their abilities and not their disabilities
- determine the appropriateness of disability documentation and to assist the student in procuring that documentation
- determine eligibility for accommodations on a case-by-case basis
- provide or arrange reasonable accommodations, academic adjustments, and/or auxiliary aids and services for students with disabilities in courses, programs, activities and facilities
- provide the Letter of Accommodation (LOA) to the student upon request
- maintain the college’s academic, conduct, and technical standards
- maintain appropriate confidentiality of records and communication
- communicate and liaison (when needed) with faculty, staff, and students
- collaborate with the faculty member and the student to provide appropriate advising and support

Students have the responsibility to:

- identify as an individual with a disability when an accommodation is necessary
- provide appropriate documentation of the disability and how it limits participation in courses, programs, services, activities and facilities
- follow the Student Disability Resource Center procedures to request accommodations in a timely manner
- present a Letter of Accommodation each term to professors for those courses in which they are requesting accommodation
- meet and discuss accommodation needs with faculty
- reserve testing accommodations within the SDRC (if this is the selected method for provision of testing accommodations as determined by the student and faculty member)
- notify the Student Disability Resource Center if accommodations are not effective
- meet qualifications and maintain essential institutional standards for courses, programs, services, activities and facilities
- meet and abide by the college’s academic, conduct, and technical standards
Faculty has the responsibility to:

- use a syllabus statement to ensure all students are aware of the Student Disability Resource Center services
- consider incorporating principles of Universal Design for Learning in your teaching, meaning to ensure that learning is accessible to all
- provide accommodations listed on the accommodation letter; meet with the student to further discuss the accommodations; contact the Student Disability Resource Center if unsure about request or if there are issues with accommodations
- provide all course materials requiring conversion to alternate format as soon as possible to the Student Disability Resource Center; students with disabilities should receive their handouts at the same time it is provided to other students in the course
- respect the student’s right to privacy and do not identify him/her to the class, or discuss disability matters in public settings
- consider the student’s disability and their access to the class materials, method of exams, and on-line learning materials
Appendix B – Confidentiality Statement

Students with disabilities are enrolling in institutions of higher education in increasing numbers.

“The Family Educational Rights and Privacy Act (FERPA) (20 U.S.C. § 1232g; 34 CFR Part 99) is a federal law that protects the privacy of students' educational records. The law applies to all schools that receive funds under an applicable program of the U.S. Department of Education. Students have specific, protected rights regarding the release of such records, and FERPA requires that institutions adhere strictly to these guidelines.” (http://registrar.fsu.edu/ferpa/)

Students with disabilities are protected from discrimination under Section 504 of the Rehabilitation Act of 1973 and the Americans with Disabilities Act of 1990 in the United States.

A student’s file, containing their documentation, their Request for Services form, and any other information concerning your case will be kept COMPLETELY CONFIDENTIAL at the SDRC. None of that information can be released to anyone outside of SDRC staff without a written permission for release signed by the student.

The SDRC staff can only discuss accommodation issues with faculty after the student has given written permission on the “Request for Services” form.
Appendix C – Student Statement of Understanding

Below is an embedded image of the form that all students sign when registering for services with the SDRC. If you have any questions about it, please email the SDRC (sdrc@fsu.edu).

FLORIDA STATE UNIVERSITY
DEAN OF STUDENTS

SDRC Statement of Student Understanding

After being approved and granted accommodations for your disability, you need to be aware of the rights you have regarding these accommodations. Likewise, you also need to understand your responsibilities that go with the accommodations.

RIGHTS

It is your right to disclose the letter of accommodation to any and all instructors. You may not need all accommodations for every class, but any professor you will need an accommodation from must have a copy of your accommodation letter.

It is your right not to use your accommodation letter for any class during a semester. This does not affect your right to have accommodations again for any subsequent semester.

It is your right to request adjustments to your accommodation letter regarding the accommodations for which you are eligible. Additions to your accommodation letter must be supported by appropriate documentation.

It is your right to have your disability kept confidential. The Student Disability Resource Center will not share information regarding your disability with any faculty, staff, parent, or other person or entity unless you have given written permission to do so (must have signed Release/Exchange of Information on file).

It is your right to have your approved accommodations provided for you free of charge, as mandated by the Americans with Disabilities Act. The Student Disability Resource Center will never charge you for your classroom accommodations.

RESPONSIBILITIES

It is your responsibility to meet with each professor during the first week of class, or within one week of receiving your accommodation letter if it is during the semester, to review your approved accommodations. The accommodation letter becomes effective on the date it is issued to the professor. Accommodation letters are not retroactive, meaning that they are only valid from the date presented to the faculty member (with a few days to implement the accommodations) forward. Professor WILL NOT go backwards and implement accommodations retroactively.

It is your responsibility to report problems with professors who are not allowing accommodations to the Student Disability Resource Center by making an appointment with a disability specialist. This must be done during the semester the problem is occurring and not after grades have been given for the course.

It is your responsibility to request a new accommodation letter for each semester that you are going to need accommodations. If you decide to add/delete approved accommodations from your accommodation letter, you will need to meet with your disability specialist in the SDRC to make the appropriate change.
Attendance: All students are required to follow class policy for attendance as outlined on the course syllabus. If you have an attendance accommodation, a signed understanding of the attendance policy must be on file at the SDRC. **NOTE:** If attendance is explained as an essential element of the course this attendance accommodation may not be applicable and will be based on an individual assessment of the course.

Recording: If a recording of lecture accommodation is granted you understand that this is for your own personal use and may not be shared in any form or manner.

Note-taking assistance: If you have note-taking assistance as an accommodation, unless an exception is noted, **you must attend class and be attentive. You do not** have the right to copies of notes from a class for which you were absent. Power Point slides and fill in the blank note packets are approved supplemental note taking accommodations. **Please remember, these are supplemental notes and you are required to still take your own notes. You may not sell, reproduce, share or in any other way distribute these notes—they are for your sole use. Any student found in violation of this agreement may have their note taking accommodation removed.**

Testing: If you require an alternative test location or extra time on examinations, it is your responsibility to arrange for this accommodation through the SDRC Testing Center and follow all requirements regarding scheduling. Additionally, remember that you must communicate with your faculty members in relation to coordination of testing. **If you receive emails from the SDRC Testing Center, it is your responsibility to respond in a timely and responsible manner. You are also responsible for informing the SDRC Testing Center of changes in test dates/times, or any cancellations. Failure to do so may result in the inability to test due to space limitations and coordination of getting the exam from the faculty member.**

Alternative Text Services: If you need textbooks or documents in an accessible format, your request must be submitted in a timely manner, with the understanding it can take up to several weeks to receive a textbook, and allowing for at least 48 hours for conversion of class materials (per document). **A receipt showing purchase of the book requested must be provided.** Services are used with the understanding that alt-text requests are based on a first-come, first-serve basis, and students must plan accordingly.

For ASL Interpreter/CART Services: Requests for interpreter/CART services should be completed immediately following your registration for classes in order to assure this accommodation is provided on the first day of class. In order to be provided Interpreter/CART Services you MUST present your accommodation letter to your instructor prior to Interpreters accompanying you to the classroom or CART services being established. Per the Interpreter Request Form, Interpreters are available for your meeting with instructors to discuss your accommodation letters.

Student Signature  Date  Disability specialist  Date

Updated 08/2015
Appendix D – Absence Accommodation Agreement

Below is an embedded PDF of the absence accommodation agreement. If you need an original copy, or feel that the language should be changed for outstandingly unique circumstances, please email the SDRC (sdrc@fsu.edu).

THE FLORIDA STATE UNIVERSITY
DEAN OF STUDENTS DEPARTMENT

Disability-Related Absence Accommodation Policy and Procedure Statement*
Students should sign and keep a copy of this statement for reference when meeting with each professor to discuss attendance and following a disability related absence.

It is expected that you will make every effort to meet with your professor to present your faculty letter early in the term, discuss it, and come to an agreement/plan on the processes and limitations of the attendance accommodation for each of your courses. Faculty members have the right to protect the integrity of their courses and certain types of courses (e.g., labs, performances, languages, group work) may necessitate stringent limits to an attendance accommodation. If you are absent due to circumstances related to your disability and need to be excused, follow this protocol:

1. At your earliest convenience, inform your instructor that you are absent due to disability related symptoms. Student Disability Resource Center (SDRC) recommends you e-mail your professor, save a copy of the message for your records and send a courtesy copy to SDRC. Contact your professor by phone if you do not have access to e-mail. It is imperative that your professor is aware of your absence as soon as possible.

2. If you visit a physician or other type of caregiver or treating professional, please obtain a signed excuse or update from that person to give to your professor and/or the SDRC.

3. You are responsible for any work or exams you miss due to an absence. Arrange to complete missed assignments and/or exams with your professor in a timely manner according to the plan you developed when you met with your faculty with the faculty letter.

4. The student must comply with these procedures for each absence related to his/her disability. Failure to communicate with the appropriate persons in a timely manner could result in loss of consideration for absences.

5. Contact the SDRC at 850-644-9566 or by email at sdrc@fsu.edu with questions and/or clarifications.

Please sign to indicate you have received a copy of this policy and procedure statement, have read, and understood its contents. *The reasonableness of absences as an accommodation is reviewed and reassessed each semester. Depending on varying circumstances, updated documentation signed by a qualified professional may be required.

Student Signature ___________________________ Date ___________

Printed name ___________________________

This form is available in alternative format upon request.
Appendix E – Agreement to Record Lectures

Below is an embedded PDF of the agreement to record lectures form. If you need an original copy, or feel that the language should be changed for outstandingly unique circumstances, please email the SDRC (sdrc@fsu.edu).

---

THE FLORIDA STATE UNIVERSITY
DEAN OF STUDENTS DEPARTMENT

874 Traditions Way/108 Student Services Building
P.O. Box 300417
Tallahassee, Florida 32306-4167
850/644-9164 • Fax 850/644-7164 • TDD 850/644-8504 • www.docs.fsu.edu/sdrc

Student Disability Resource Center
Agreement to Record Lectures as an Approved Accommodation*

I am a student registered with the Florida State University’s Student Disability Resource Center. One of my approved accommodations is the ability to tape record the lectures (audio recording).

I agree that:
1. The contents of this course are the property of the professor.
2. The recordings are solely for my access in this course, the contents will be used for this course only and for current semester only.
3. I will not share the recordings in part or in whole with any other person.
4. I will only use the recordings for this course and therefore will delete all recorded lectures at the end of the semester (immediately after taking the final exam) or immediately after I drop the course.

The expectations of this accommodation have been discussed and understood. Student

_________________________  __________________________
Student Signature          Date

_________________________
Printed name

_________________________  __________________________
SDRC Staff Signature       Date

_________________________  __________________________
Instructor Signature       Date

This Form is Available in Alternative Format Upon Request
Appendix F: Principles of UD for Instruction (UDI)

An adaptation of the basic seven principles of universal design by Scott, McGuire and Shaw (2003)\(^1\) that focuses specifically on higher education needs by adding two additional principles and also offers guidelines and examples that fit into the instructional model.

<table>
<thead>
<tr>
<th>Principle</th>
<th>Definition (Guidelines)</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principle 1: Equitable use</td>
<td>Instruction is designed to be useful to and accessible by people with diverse abilities. Provide the same means of use for all students; identical whenever possible, equivalent when not.</td>
<td>Provision of class notes online. Comprehensive notes can be accessed in the same manner by all students, regardless of hearing ability, English proficiency, learning or attention disorders, or note-taking skill level. In an electronic format, students can utilize whatever individual assistive technology is needed to read, hear, or study the class notes.</td>
</tr>
<tr>
<td>Principle 2: Flexibility in use</td>
<td>Instruction is designed to accommodate a wide range of individual abilities. Provide choice in methods of use.</td>
<td>Use of varied instructional methods (lecture with a visual outline, group activities, use of stories, or web board–based discussions) to provide different ways of learning and experiencing knowledge.</td>
</tr>
<tr>
<td>Principle 3: Simple and intuitive</td>
<td>Instruction is designed in a straightforward and predictable manner, regardless of the student’s experience, knowledge, language skills, or current concentration level. Eliminate unnecessary complexity.</td>
<td>Provision of a grading rubric that clearly lays out expectations for exam performance, papers, or projects; a syllabus with comprehensive and accurate information; or a handbook guiding students through difficult homework assignments.</td>
</tr>
<tr>
<td>Principle 4: Perceptible information</td>
<td>Instruction is designed so that necessary information is communicated effectively to the student, regardless of ambient conditions or the student’s sensory abilities.</td>
<td>Selection of textbooks, reading material, and other instructional supports in digital format or online so students with diverse needs (e.g., vision, learning, attention, English as a Second Language) can access materials through traditional hard copy or with the use of various technological supports (e.g., screen reader, text enlarger, online dictionary).</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Principle</th>
<th>Definition (Guidelines)</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principle 5: Tolerance for error</td>
<td>Instruction anticipates variation in individual student learning pace and prerequisite skills.</td>
<td>Structuring a long-term course project so that students have the option of turning in individual project components separately for constructive feedback and for integration into the final product; provision of online “practice” exercises that supplement classroom instruction.</td>
</tr>
<tr>
<td>Principle 6: Low physical effort</td>
<td>Instruction is designed to minimize nonessential physical effort in order to allow maximum attention to learning.</td>
<td>Allowing students to use a word processor for writing and editing papers or essay exams. This facilitates editing of the document without the additional physical exertion of rewriting portions of text (helpful for students with fine motor or handwriting difficulties or extreme organization weaknesses, and provides options for those who are more adept and comfortable composing on the computer).</td>
</tr>
<tr>
<td>Principle 7: Size and space for approach and use</td>
<td>Instruction is designed with consideration for appropriate size and space for approach, reach, manipulations, and use regardless of a student’s body size, posture, mobility, and communication needs.</td>
<td>In small class settings, use of a circular seating arrangement to allow students to see and face speakers during discussion—important for students with attention deficit disorder or who are deaf or hard of hearing.</td>
</tr>
<tr>
<td>Principle 8: A community of learners</td>
<td>The instructional environment promotes interaction and communication among students and between students and faculty</td>
<td>Fostering communication among students in and out of class by structuring study groups, discussion groups, e-mail lists, or chat rooms; making a personal connection with students and incorporating motivational strategies to encourage student performance through learning students’ names or individually acknowledging excellent performance.</td>
</tr>
<tr>
<td>Principle 9: Instructional climate</td>
<td>Instruction is designed to be welcoming and inclusive. High expectations are espoused for all students.</td>
<td>A statement in the class syllabus affirming the need for class members to respect diversity in order to establish the expectation of tolerance as well as encourage students to discuss any special learning needs with the instructor; highlight diverse thinkers who have made significant contributions to the field or share innovative approaches developed by students in the class.</td>
</tr>
</tbody>
</table>
Appendix G - Grievance/Complaint Procedures for Persons with Disabilities

Objective

The purpose of these procedures is to ensure that the Florida State University complies with the provisions of the Americans With Disabilities Act of 1990 as amended (ADA), Rehabilitation Act of 1973, as amended (Section 504) and that faculty, staff, students, applicants, and visitors with disabilities are provided the means to seek recourse in the event a violation is perceived to have occurred.

Authority

These procedures are authorized under the ADA and are consistent with the requirements of Section 504.

Policy

All members of the University community are entitled to learn, study, and work in an atmosphere free from illegal discrimination. The University’s equal opportunity policies prohibit discrimination against students, employees, applicants, or visitors on the basis of their disability as well as race, creed color, sex, religion, national origin, age, veteran or marital status, sexual orientation, gender identity, gender expression, or any other protected group status. Under the Non-Discrimination Policy intent to discriminate is irrelevant, the focus is instead on whether students, employees, or applicants have been treated differently or subjected to an intimidating, hostile, or offensive environment as a result of their disabilities.

Procedures

Any grievances or complaints alleged as violations of the Americans With Disabilities Act as amended (hereafter referred to as ADA), to include denials of reasonable accommodation requests, may be filed with the Student Disability Resource Center, the Dean of Students, Dean of the Faculties, or the Human Resources Department. These offices will receive, review, and investigate the complaint(s) and work towards achievement of full resolution. Ultimately, all intakes of complaints or grievances should be listed or reported to the University ADA Coordinator, for monitoring and record-keeping purposes. The responsible University offices will not concurrently investigate any ADA-related complaints or grievances, and where possible, should confer to avoid duplication of efforts. The ADA Coordinator will monitor investigations to ensure expeditious resolution.
Student Complaints

Complaints filed by students and student applicants with disabilities will be handled by the Dean of Students Department. Complaints that should appropriately be handled under other existing student grievance procedures will be referred accordingly. The Student Disability Resource Center will complete an investigation of the complaint, prepare written findings regarding probable cause, and submit a recommendation for resolving the complaint to the responsible University administrator(s) for action immediately upon completion of the investigation.

Faculty Complaints

Complaints filed by faculty and faculty candidates with disabilities will be handled by the Office of the Dean of the Faculties. Complaints that should appropriately be handled under other existing faculty grievance procedures will be referred accordingly. The Office of the Dean of the Faculties will complete an investigation of the complaint, prepare written findings regarding probable cause, and submit a recommendation for resolving the complaint to the responsible University administrator(s) for action immediately upon completion of the investigation. Please refer to FSU’s Non-Discrimination Policy and Complaint Procedures available at http://policies.vpfa.fsu.edu/personnel/3i.html#3.

Staff Complaints

Complaints filed by staff and employment applicants with disabilities will be handled by the Human Resources Department. Complaints that should appropriately be handled under other existing employee grievance procedures will be referred accordingly. The Human Resources Department will complete an investigation of the complaint, prepare written findings regarding probable cause, and submit a recommendation for resolving the complaint to the responsible University administrator(s) for action immediately upon completion of the investigation. Please refer to FSU’s Non-Discrimination Policy and Complaint Procedures available at http://policies.vpfa.fsu.edu/personnel/3i.html#3.

Visitor Complaints

Any visitor to campus with a disability (e.g., parent, patron, consultant, etc.), may report an alleged violation or register a complaint directly to the University ADA Coordinator, Office of University Human Resources. The ADA Coordinator will verify the information presented, evaluate the merits of the complaint, and submit a recommendation for action to the appropriate University administrator(s).
Review Process

The following procedures will be used for all complaints or grievances alleging violations of the ADA or Section 504:

1. All complaints alleging violation of the ADA or Section 504 must be made in writing to the appropriate investigating department within sixty (60) class days of the alleged violation or claim of failure to provide reasonable accommodation. The written complaint should specify the time, place, and nature of the act claimed to be in violation and may be supplemented by supporting documents and/or affidavits from persons having firsthand knowledge of the facts. A student complaint must be filed within thirty (30) class days of the end of the term in which the alleged violation occurred.

2. The appropriate department will investigate all pertinent facts and circumstances in support of the alleged violation with twenty (20) class days of receipt of the complaint, to include review and verification of all documentation and testimony by involved and/or knowledgeable parties.

3. The investigating department may attempt resolution of a complaint through mutual agreement of the affected parties at any point during the course of the investigation. Should such resolution be achieved, the investigation shall be ended. The terms and conditions of the resolution agreement shall be issued to the charging party and the appropriate administrator of the party or department charged within ten (10) class days for review and signatures.

4. Where resolution through mutual agreement is not achieved, written findings from the investigation, along with a recommendation for resolving the complaint shall be forwarded simultaneously to the charging party, responsible administrator of the charged department and the University ADA Coordinator immediately upon completion of the investigation.

5. A complainant with a disability who believes that his or her grievance has not been handled appropriately, should bring this to the attention of the University ADA Coordinator.

6. The responsible administrator shall take final action on the recommendation within ten (10) class days after receipt of the recommendation. Consultation will be provided by the University ADA Coordinator as requested.

7. Either party may appeal the findings of the investigating department to the University President (or the President’s designee) by filing a request for a review of a complaint alleging discrimination on the basis of disability or failure to provide reasonable accommodation within ten (10) class days of receipt of finding.

8. Within seven (7) class days of receipt of the initial findings, the University President (or designee) may render a final decision on the complaint or choose to appoint a hearing panel to review the appeal. If a hearing panel is used, the President shall appoint a three
to five member hearing panel that will include at least one person with a disability. In the case of a student appeal, the panel shall include at least one student with a disability. The hearing panel shall conduct a hearing, consider evidence and testimony in justification of the appeal, and render its decision within twenty one (21) days of appointment. The President may accept, reject, or modify the decision of the review panel.

9. Upon final resolution of a complaint, copies of records will be forwarded to and maintained by the ADA Coordinator, Office of University Human Resources. All records relating to complaints of failure to provide reasonable accommodations are evaluative in nature and all medical information contained in complaint records shall be deemed confidential pursuant to, but not limited to, the provisions of Sections 240.237, 240.253, 228.093, 455.241, Florida Statutes.

**External Complaint Resources**

Students, faculty, staff, or visitors who believe that the university established system have failed them or insufficient to address their complaint may also contact the Office of Civil Rights at [http://www2.ed.gov/about/offices/list/ocr/docs/howto.html](http://www2.ed.gov/about/offices/list/ocr/docs/howto.html).
Appendix H: Accessibility Checklists

These checklists are adapted from Temple University's training materials. For further information about document accessibility and a list of resources, visit their document accessibility webpage: https://accessibility.temple.edu/how-materials/website-and-document-accessibility.

PDF Accessibility Checklist

Note: Although it is possible to create an accessible PDF document and possible for a user to read the document if equipped with the appropriate software, many users and advocacy groups continue to recommend that PDF documents be accompanied by alternative format documents that are more universally accessible, such as an accessible Word Document or HTML (web page).

☐ **The original document meets all guidelines for accessibility.**
  Rationale: PDF files are typically created in some other application or by scanning existing documents. Review the Guidelines & Standards for creating accessible text, spreadsheets, and presentations before creating your PDF version. Begin with an accessible text document BEFORE converting to PDF.

☐ **Verify the document is a searchable text file, not an image-only scan.**
  Rationale: Documents scanned without OCR (optical character recognition) may appear to an assistive technology as large images without readable/selectable text.

☐ **Indicate document structure and non-text elements by tags.**
  Rationale: Well-formed, tagged PDF documents ensure logical reading order, that all text is selectable and readable for assistive technology, and that users can navigate the document using document structure (e.g. headings, footers, page numbers, etc.)

☐ **Ensure clear reading order is easy to follow.**
  Rationale: PDF files created from brochures and other documents with tables, columns, and multi-page articles may result in unexpected reading order or document flow.

☐ **Specify the document language.**
  Rationale: Setting the document language in a PDF enables some screen readers to switch to the appropriate language.

☐ **Select document fonts that allow characters to be extracted to text.**
  Rationale: Custom fonts or symbol-based fonts may not be readable by screen readers or other assistive technologies. Users should be able to select an alternate font to view/print the document.

☐ **Set document permissions to allow access for assistive technology.**
  Rationale: A document author can specify that no part of an accessible PDF is to be
copied, printed, extracted, commented on, or edited. This setting can interfere with the user of a screen reader’s ability to read the documents screen readers must be able to copy or extract the document’s text to convert it to speech.

☐ Provide alternative descriptions for images, formulas, and other items that do not translate naturally into text.
   Rationale: non-text elements such as pictures, graphs, charts, and other items require alternative text to describe the visual characteristics.

☐ Mark up data tables with proper table structure including row and column headings.
   Table summaries are optional unless the table data cannot be understood without it.
   Rationale: when tables are used to organize or present data (and not for layout), they must include additional markup to ensure users can associate the content of each cell with its appropriate modifiers.

☐ Add tags to links created through annotations/PDF mark-up.
   Rationale: Links added to a PDF after it is created associates the link with the geographic region of the page and not in the regular flow of the text. In order to ensure the link is available for keyboard and assistive technology users, additional tags must be added to identify the link location within the reading flow of the text.

☐ Mark up/tag lists to group list items together.
   Rationale: Assistive technology will recognize and group together items identified as part of a list. Without this information, users may have difficulty navigating the list and interpreting the start and end of the list. If list tags were not generated in the original document, they should be added after conversion to PDF.

☐ For documents with original pagination, add PageLabels to reflect the page number formatting, including appendices and front matter.
   Rationale: if PageLabels has not been provided to describe the page number formatting, the page numbering scheme will not be reflected in the Page Navigation toolbar in Adobe Acrobat Pro or Reader. This toolbar displays the page number in a text box, which users can change to move to another page. In addition, users can select the arrows to move one page up or down in the document. PageLabels help users locate themselves in a document by ensuring that the page numbering displayed in the PDF viewer page controls has the same page numbering as the document.

☐ Add navigational aids to long documents (6 or more pages)
   Rationale: Users without a mouse for scrolling and users of assistive technology utilize bookmarks and tables of content to quickly navigate to relevant sections of longer documents.
MS Word Accessibility Checklist

☐ Before distributing the file, address all warnings and errors in the Microsoft Word Accessibility checker (File -> Info -> Prepare for Sharing -> Check Accessibility)
Rationale: The accessibility checker addresses a number of accessibility issues. The Accessibility checker is available in Microsoft Office 2010 and 2013.
Note: The document will need to be saved in a .DocX format before using the Accessibility Checker.

☐ Structure the document using styles for headings (not just bold, italics and/or a different font size) and other formatting elements (such as color). (Styles are on the right side of the Home tab)
Rationale: Screen reader users navigate through a document using heading styles. Styles also convey emphasis and semantic meaning, where formatting (i.e. bold, or size) does not.

☐ Use the column or table feature to create columns. (Tables are on the insert tab, columns are on the page layout tab)
Rationale: Screen readers read left to right top to bottom. Using the column feature will override this and allow the information to be read top to bottom before being read across. Avoid using tabs and/or spaces to create columns.

☐ Use text in addition to the color to convey information (e.g. "Important items are red and marked with an *.")
Rationale: Color blind students may not discern different colors ("required items are in red"), and need a textual marker (such as an * next to the required item).

☐ Make document available in either Microsoft Office (.doc or .docx) or Rich Text (.rtf) format.
Rationale: Microsoft Office and Rich Text files are easily processed by screen readers or other tools used to provide materials in alternate formats.

☐ If the permissions of the document are set to prevent editing, provide an additional copy of document as accessible PDF or HTML (web page).
Rationale: Students with poor visual acuity and those with certain learning disabilities, such as dyslexia, may need to alter text with poor contrast, small type, or fonts with serifs.

☐ Render any mathematical equations or scientific notation used in the document beyond basic operations (e.g., addition, subtraction, multiplication, and division) in an accessible MathML format through the use of an equation editor (e.g., MathType).
Rationale: Equations are often read by screen readers as graphics and not as actual equations, or the order of the equation is jumbled. MathML can be used to avoid this.
Note: The equation editor in Microsoft Word cannot produce accessible MathML.
☐ Make sure any videos in the document have closed captions, and any audio has a transcript.
Rationale: Captions (videos) or transcripts (audio files) are essential components of multimedia access for individuals with hearing loss or auditory processing issues.

Additional usability considerations (suggested but not required):

☐ (Optional) Long documents (more than about 12 pages) should include a Table of Contents (inserted via the References tab, not manually created), and page numbers which are automatically updated.
Rationale: A Table of Contents inserted via the Review tab has internal links which allow screen reader users to jump to the relevant parts quickly.

☐ (Optional) Text descriptions of links to websites should be explicit in describing what the reader will encounter when clicking the link (i.e. "Temple University Policies website.")
Rationale: Screen reader users often list the hyperlinks in a document; a series of "read more" links is meaningless. “Mike’s Auto Shop” is more meaningful than http://www.mikefixescars.com.

PowerPoint Accessibility Checklist

☐ Before distributing the file, address all warnings and errors in the Microsoft Accessibility checker.
Rationale: The accessibility checker addresses a number of accessibility issues. The Accessibility checker is available in Microsoft Office 2010 and 2013.

☐ Utilize slide layout templates provided by program when creating presentation.
Rationale: Slide layout templates have been tested to work with screen readers. Templates assist with readability and reading order for screen readers. Avoid drawing or creating ad-hoc text or content areas onto layouts.

☐ Use text in addition to the color to convey information (e.g. "Important items are red and marked with an *").
Rationale: Color blind students may not discern different colors ("required items are in red"), and need a textual marker (such as an * next to the required item).

☐ Deactivate self-advancing (timed) features.
Rationale: Slides that advance on a timer restrict individuals from accessing all information on slide. Individuals work through information at different paces, all self-pacing to ensure better retention of information on slide.
☐ Include all information depicted on slides in outline view.
Rationale: Screen reader software reads text information off the outline view, not the actual slide. Thus any information not included in the outline will not be accessible to someone using a screen reader.

☐ Verify that information in outline view is in same order as in presentation mode.
Rationale: Reading order is essential to ensure information is comprehensible and understood as intended. Review outlines and makes changes to ensure that text information is presented in same reading order as presented on slide.

☐ Include detailed alternate text for non-text items (e.g. pictures, tables, graphs, charts, etc.) embedded in the slide content or in the notes section of the slide.
Rationale: Any essential information for an image must be relayed via text description to ensure access as screen readers cannot interpret image files.

☐ Include captions or an embedded transcript for any video or audio components.
Rationale: Captions (videos) or transcripts (audio files) are essential components of multimedia access for individuals with hearing loss or auditory processing issues.

☐ Allow users to modify font (size and family) and colors (backgrounds and text color).
Rationale: Clear, clean, and simple text is the best way to effectively relay information. Anything that impedes the readability of a slide impacts the efficacy of the teaching. Use of things like word art and fancy fonts can impact readability by individuals or screen readers.

Checklist for Oral Presentation:

☐ Use minimally-patterned slide backgrounds and remove excessive animation or rapidly flashing elements.
Rationale: Extraneous visual gimmicks, like flashing text or excessive transitions, may disrupt the information presented and pull focus away from the content. Animation can cause migraines or seizures.

☐ Describe any Information available only in visual format (e.g. images like pictures, tables, graphs) or auditory format (e.g. audio clips, music, etc.) during presentation.
Rationale: Any information presented visually on the PowerPoint should be referenced in detail during presentation. Essential information should be verbalized. Presenters should draw attention to auditory information being portrayed (e.g. audio clips) so an individual with hearing loss is aware, as an individual who is focusing on speaker can miss other auditory information being shared if not alerted.

☐ Indicate slide transition with a sound or vocal announcement (e.g. “next slide”)
Rationale: Indicating when a new slide is being presented helps users follow with notes, handouts, or personal electronic copies.
Additional usability considerations for Presentations (suggested but not required):

- **(Optional) Use simple sans serif fonts at no less than 24 points.**
  Rationale: serif fonts can make letters difficult to distinguish on screen; smaller fonts are often unreadable from the back of the room.

- **(Optional) Select a high contrast with background with limited decoration.**
  Rationale: high contrast colors will help ensure text is readable even in poorly lit rooms. Busy slides with lots of decorative backgrounds can be distracting.

- **(Optional) Share presentation files with individuals electronically before the live presentation so individuals who utilize screen readers or enhancers will be able to access the file before, during, or after the course.**
  Rationale: Sharing an accessible electronic copy before the class is essential to allow each student to access the file however necessary for access. The professor has only to create the accessible version and share it; students are responsible for the end result (e.g. enlarged printouts for visually impairments, screen reader for blindness, printouts with notes areas for Attention Deficits, etc.).